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About POST INVENTORY _______________________________________  Back to Contents 

POST INVENTORY is the interface for manually uploading your company’s inventory data to your 
WarehouseTWO account, so that other members can see (and buy!) your inventory.  Making your 
inventory data available to other members has these benefits: 

 Increased Revenue:  Expand your sales territory, by offering your inventory for sale to peer 
wholesaler-distributors.  Your available inventory is someone else’s surprise, critical backorder. 

 Asset Recovery:  Turn unwanted inventory into cash.  Your surplus inventory is someone else’s 
surprise, critical backorder or actively sold item. 

POST INVENTORY is a premium feature.  It is available only to accounts with memberships at level 2 or 
higher.  Only account administrators can access this feature. 
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Functionality Overview __________________________________________  Back to Contents 

 

The POST INVENTORY screen has these functions and fields: 

 Upload a List of items and Browse…:  Click on the Browse… button to find your upload file on your 

computer’s hard drive.  When found, the file name and path will appear in the window to the left. 

 UPLOAD:  Click on this button to upload the found inventory data file. 

 Find a Part Number to Edit:  Type any portion of a part number into this field.  Then click on the 

SEARCH button ().  See more below. 

 SEARCH:  After typing in a portion of a part number, or a complete part number into the search field 

(), click this button to filter the list of posted items () to just those items that meet your search 
criteria.  This will help you find a particular item that you want to edit or delete. 

 RESET:  Click this button to clear your previous search results and restores the displayed list of items 

() to the original view. 

 Add New Item:  Click on this link to bring up the Add/Edit screen, in which you can manually add a 

single inventory data record. 

 Posting Templates:  Click on either link to download your account’s unique inventory posting 

template file.  Two formats exist:  MS Excel and .txt.  Refer to the section Inventory Data File Formats 
and Requirements in this tutorial for more information on what to do with either template file. 

 Delete Inventory:  Click on this link to delete all of your posted inventory data.  The link, Delete All 
Posted Items, is a global action, and will delete all inventory data records to posted to all locations.  
Clicking on this link opens a confirmation window (giving the choice to cancel or proceed).  The link, 
Delete All Items Posted at a Single Location, allows for selecting a single location from which to 
delete all posted inventory data records.  Clicking on this link opens a window in which a single 
location can be selected.  Selecting a record opens a opens a confirmation (“cancel or proceed?”) 
window. 

 Currently posted items (table):  The header shows you how many items are posted to your account 

and how many your membership level allows.  The table shows currently posted items, fifteen per 
screen.  Click on any column header label in blue to sort the list by that column, ascending.  Click on 
the column header again to sort descending. 

 # Items per Page:  Dropdown list to select how many items will appear per screen.  Choices are 

“10”, “25”, “50” and “100”. 

 Navigation Buttons:  Clicking on these buttons allows scroll through the list of posted items. 

 

 
 

 

 

  

 

  

 
 

  
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Location Settings that Affect Posted Inventory Data _______  Back to Contents 

 

Prior to uploading inventory data for the first time, review the entries and settings on each of your 
Location records.  Under the ADMINISTRATIVE TOOLS menu, select Account Settings.  On the 
Account Settings screen, click on the Locations tab.  On the Locations screen, click on a location 
name.  The screenshot below shows the “Edit Location” pop-up window.  The address information, 
contact information (name, email address and phone number) and “How to Order” contents are 
associated with all inventory data records posted to this location and will be displayed on the “Source 
Detail” screen that appears when one clicks on a part number displayed in a SEARCH or MULTI-
SEARCH result. 

 

There are four settings on the Edit Location screen that affect your inventory data postings: 

 Default Currency:  This setting determines in which currency your prices will be displayed in 

SEARCH and BARGAIN HUNT results.  The default setting is $USD.  Click on the drop-down arrow, 
and then click on an alternative currency.  Contact us if you do not see your country’s currency. 

 Inventory Posting Expiration:  This determines when your posted data will be automatically deleted 

from your account.  Choices are: 

After 1 Day: items are removed from the site twenty-four hours after posting (recommended for 
those members who POST new information daily via FTP uploads)  

After 7 Days: items are removed from the site seven days after posting (recommended for those 
members who POST new information weekly or only on weekdays)  

 

 

 

 

 
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After 30 Days: items are removed from the site thirty days after posting (recommended for those 
members who manually POST new information monthly)  

After 90 Days: items as removed from the site ninety days after posting (not recommended, but 
acceptable for those members who manually POST information on slow-moving or 
dead stock only)  

After 365 Days: items as removed from the site three hundred sixty-five days after posting (not 
recommended, but acceptable for those members who manually POST new 
information on dead stock only) 

 Web Market Location:  When this box is checked, inventory data records posted to this location will 

NOT appear in SEARCH results at WarehouseTWO.  But they might appear in searches in Google or 
Bing/Yahoo.  Refer to our WEB MARKET tutorial for more information about this functionality. 

 Exclude from Search Results:  When this box is checked, inventory data records posted to a WEB 

MARKET location will not appear in SEARCH results at the WarehouseTWO website.  When 
unchecked, WEB MARKET items may appear in SEARCH results at the WarehouseTWO website, 
unfiltered by community.  That is, any WarehouseTWO member would be able to find your WEB 
MARKET items. 

 Auto-Delete Unrefreshed Records:  When this box is checked, inventory data records not updated 

by the most recently uploaded inventory data file that contains at least one record assigned to this 
location will be automatically deleted immediately after that most recently uploaded inventory data file 
has been processed by the WarehouseTWO system.  That is, this feature over-rides the Inventory 

Posting Expiration setting (). 
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Inventory Data File Content and Format Requirements ____ Back to Contents 

Inventory Data File Content 

Each inventory item record in an upload file must contain these seven fields, in sequence: 

1. Location ID a unique number assigned to each location record in your WarehouseTWO 
account; these numbers are available in your company’s unique inventory-
posting template, downloadable from our web site 

2. Product Line ID a unique number assigned to each inventory-sharing community in which your 
account participates; these numbers are available in your company’s unique 
inventory-posting template, downloadable from our web site 

3. Part Number free-form text field, usually containing a manufacturer’s exact part number, as 
defined by each manufacturer 

4. Description free-form, text field; optional, but the file must have this field, even if it is blank; 
recommended maximum filed length:  50 characters 

5. Quantity numerical value field, limited to eight digits; we accept decimal places 

6. UOM “Unit of Measure”, free-form text field; maximum length:  four characters (the 
system will truncate longer values when processing uploaded data files);  refer to 
Appendix I for details on how UOMs are modified when files are uploaded 

 

Most Commonly Used UOMs 

EA each 

FT (linear) foot 

YD (linear) yard 

 

Other Recommended UOMs 

BOX quantity and UOM per box to be specified in item description 

CC cubic centimeter 

CFT cubic foot 

CIN cubic inch 

CYD cubic yard 

GAL 

G 

gallon 

gram 

IN 

KG 

linear inch 

kilogram 

LB pound 

LTR liter 

M linear meter 

PINT pint 

PKG quantity and UOM per package to be specified in item description 

QT quart 

RL reel or roll 

SQFT square foot 

SQIN square inch 

SQM square meter 

SQYD square yard 

 

7. Price numerical value field; optional, but the file must have this field, even if it is blank; 
limited to eight digits, truncated to two digits to the right of the decimal place 
(rounded) when displayed at the WarehouseTWO website 
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A unique inventory item record is a unique permutation of these three fields: 

Location ID 

Product Line ID 

Part Number 

It is possible to upload the same item to multiple locations on your account (a feature available only to 
memberships at level 3 and higher), and you can upload the same item to multiple inventory-sharing 
communities.  (Some manufacturers sell the same item, with the same part number, under multiple 
brands, for which we create multiple inventory-sharing communities at WarehouseTWO.  Members who 
sell both brands may post their inventory to both brands’ communities.) 

 

Acceptable Inventory Data File Formats 

We accept two file formats:  a completely unformatted, single-worksheet MS Excel file (.xls or .xlsx), or a 
pipe-character-delimited text file (.txt).  The pipe character is the vertical bar on the “backslash” key:  “|”.  
If you intend to automatically create and upload an inventory data file, we recommend that you create a 
pipe-character-delimited text file.  If you intend to manually create and upload an inventory data file, we 
recommend that you create a properly unformatted MS Excel file. 

 

MS Excel File Format Requirements 

 

The MS Excel workbook must contain seven columns of data per item record, each column 
corresponding to each value listed in the Inventory Data File Content section of this tutorial.  Additional 
requirements of this file are: 

a) () The first row MUST contain the column headers exactly as shown in the MS Excel 
inventory posting template. 

Your account’s unique MS Excel inventory posting template is available for downloading from our 
web site.  (Refer to Posting Templates, item  in the Functionality Overview section of this tutorial.)  
This template file contains ID numbers assigned to your account, and includes the column header 
fields.  The file must contain seven columns of data, and row “1” must contain the column headers as 
shown in your template file. 

b) The file may not have any blank rows between rows of data. 

c) Cells in columns A, B, C, E and F must be populated for every row of data. 

Valid values for the first two columns are shown in your account’s unique inventory posting template. 

d) Column D, "Product_Description", entries are optional (but the column must still be included, 
and the top cell must contain the column header). 

e) Column G, "Product_NetPrice", entries are optional (but the column must still be included, 
and the top cell must contain the column header). 

f) () The MS Excel file must contain only one worksheet. 

Most computers’ MS Excel programs are set up to have new files contain three blank worksheets.  
Either remove two of these worksheets, or change your program’s settings to limit the number of 
worksheets in a new file to one.  (In MS Excel, go to “Tools”, “Options”, “General”; change the setting 
for “sheets in new workbook” to “1”.) 

 

 
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g) There must not be any formatting done to any cell in the MS Excel file.  Seriously. 

This is where people are most likely to go wrong.  Any formatting will cause the file to not upload 
successfully.  So do not change fonts.  Do not justify entries in cells.  Do not round prices.  Do not 
add a currency sign to prices.  Do not add borders or shading to cells.  Do not paste formatted cells 
from another Excel file into the file you intend to upload.  Refer to Appendix II for suggestions on how 
to remove all non-default formatting from an Excel file. 

Column widths in the MS Excel spreadsheet are not fixed.  All fields are unlimited in length, including the 
description field.  But please limit your descriptions to fifty characters, just so they appear nicely in search 
results.  Also, try to keep your units of measure (“UOM”) to no more than four characters. 

The name of the file does not matter, as long as its extension is “.xls” or “.xlsx”. 

The screenshot below shows a typical inventory-posting template file in MS Excel format.  Your account’s 
unique MS Excel inventory posting template is available for downloading from our web site.  (Refer to the 
Functionality Overview section of this tutorial.) 

 

Features and contents of this template file: 

 Column Header Labels:  These values, exactly as they appear in this template, must appear in the 

first row of your MS Excel inventory data file. 

 Location IDs:  A unique ID number has been assigned to each of the locations set up in your 

member account.  One of these ID numbers must populate the first column of data for each of your 
inventory data records in an MS Excel inventory data file. 

 Product Line IDs:  A unique ID number has been assigned to each of the inventory-sharing 

communities activated on your member account.  One of these ID numbers must populate the second 
column of data for each of your inventory data records in an MS Excel inventory data file.  
“Authorized” and “unauthorized” communities are listed here. 

 Tips:  This section contains a brief list of tips on how to format an MS Excel inventory data file. 

 

 

 

 
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Common Mistakes Made in an MS Excel File: 

 The Excel template file is not saved as an Excel file (.xls or .xlsx) prior to using it as an inventory data 
upload file.  This template file downloads as a tab-delimited text file (.txt), which is not an acceptable 
inventory data upload file format. 

 The file contains formatting, such as rounded prices, prices formatted to display a currency symbol, 
justified cells, or values (in the first two columns) entered as text. 

 The column header row does not contain the column header titles, as shown in the template file. 

 The file contains invalid values in either of the first two columns. 

 The file contains records with a blank cell in column A, B, C, E or F. 

 The file contains duplicate records. 

 The file contains extra (empty) worksheets. 

 

Pipe-Delimited File Format Requirements 

 

The pipe-delimited text file must contain seven fields of data per item record, listed in the Inventory Data 
File Content section of this tutorial.  Each field must be separated by a pipe character (“|”).  Even if a 
record does not have any values for “description” or “price”, the record must have six pipe character field 
separators in the line.  Records are separated by a single carriage return.  This type of file does not need 
to include the first row of column header labels that the MS Excel file requires. 

The name of the file does not matter, as long as its extension is “.txt”. 

The screenshot below shows a typical inventory-posting template file in text (.txt) format.  Your account’s 
unique text inventory posting template is available for downloading from our web site.  (Refer to Posting 
Templates, item  in the Functionality Overview section of this tutorial.) 

 

 

 

 

 

 

 
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Features and contents of this template file: 

 Value Definitions:  This section defines the seven fields for each inventory data record.  Each field is 

to be separated by a single pipe-character (“|”); each record is to be separated by a single carriage 
return in the text file. 

 Location IDs:  A unique ID number has been assigned to each of the locations set up in your 

member account.  One of these ID numbers must populate the first value position for each of your 
inventory data records in a text inventory data file. 

 Product Line IDs:  A unique ID number has been assigned to each of the inventory-sharing 

communities activated on your member account.  One of these ID numbers must populate the second 
value position for each of your inventory data records in a text inventory data file.  “Authorized” and 
“unauthorized” communities are listed here. 

 Tips:  This section contains a brief list of tips on how to format a pipe-character delimited text 

inventory data file. 

 

Common Mistakes Made to a Pipe-Character-Delimited Text File 

 The file has an extension other than “.txt”. 

 The delimiter used is other than the pipe character (“|”), such as a tab or comma.  The WarehouseTWO 
system does not accept tab-delimited text files (“.txt”) or comma-separated variable files (“.csv”). 

 The file contains invalid values in either of the first two fields. 

 The file contains duplicate records. 

 At least one record is missing one or more pipe character delimiters; regardless of whether you include 
a description or price, each data record must contain six pipe-character delimiters. 
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How to Manually Upload an Inventory Data File _____________  Back to Contents 

 

Step #1: Download a copy of your company’s unique inventory posting template file (), in either Excel 
or pipe-character-delimited text format.  (This needs to be done only once, unless changes 
have been made to your account relating to locations and access to communities.) 

Step #2: Using either template file, and following the guidelines shown in the Inventory Data File Content 
and Format Requirements section of this tutorial, create an inventory data file. 

Step #3: If your newly created inventory data file is intended to replace all data currently posted to your 
account or to a specific location, click on either the Delete All Posted Items Records or the 
Delete All Items Posted at a Single Location link () to delete currently posted data.  Doing 
so ensures that no invalid or outdated data remains posted to your account. 

Step #4: Click on the Browse… button ().  This will open a pop-up navigation window.  Navigate to 
find your inventory data file on your local storage device, such as your computer hard drive.  
After selecting the desired file, click on the “OPEN” button in the pop-up window. 

Step #5: Prior to clicking on the UPLOAD button, note the number of Currently posted items on your 
account ().  (If you followed step #3 above, the number will be zero.)  A change in this 
number will be verification that your data file was successfully uploaded and processed. 

Step #6: Click on the Upload button ().  A moving icon on the screen will indicate that your file is being 
uploaded.  Depending on the size of your data file and the speed of your internet connection, it 
may take as long as two minutes for your data file to be uploaded.  (we recommend uploading 
files containing more than 10,000 records via FTP.  Contact us to request an FTP account.) 

Upon completion of receiving and processing your file, a pop-up window similar to the one shown below 
will appear.  Click “OK” to close this window.  If any records were successfully uploaded or updated the 
number of Currently posted items () will have changed. 

 

  

 

  

 
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Limits and Exceptions Associated with Uploading and Inventory Data File 

You are limited as to how many inventory data records can be posted to your account at any given time.  
(Refer to WarehouseTWO’s membership levels for limits by membership level.)  Whether adding a new 
data file that exceeds the limit assigned to your membership level, or additional records to records 
currently posted, the WarehouseTWO system will not upload any additional records beyond your 
account’s limit. 

Records with “null” values in any field other than “Description” or “Net Price” will be ignored. 

Records with negative or zero “Quantity” values will be ignored.  (Trick:  Uploading an inventory data 
record with a zero quantity will delete a previously posted record of that same item.) 

If an inventory data file contains duplicate records, only the last occurrence of the record in the file will 
remain uploaded.  (The WarehouseTWO system does not total the quantities assigned to duplicate 
records.)  A unique record is defined as a unique permutation of Location ID, Product Line ID and Part 
Number. 

https://www.warehousetwo.com/levels.aspx
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How to View and Review Posted Inventory Data ____________  Back to Contents 

 

Depending on the # Items per Page setting selected (), the first 10, 25, 50 or 100 currently posted 
inventory data records are displayed on the bottom half of the POST INVENTORY screen ().  You can 
re-sort this list by clicking on any of the column headers shown in blue font. 

Use the navigation buttons () to scroll through the list of posted inventory data records. 

Click on the Export Current Postings To File link () to export your currently posted inventory data 
records.  This export data file is not in the correct format to re-upload the same data. 

 

The exported inventory data file contains these columns of data: 

A: Product_Location_Id:  This is field #1 in an inventory data record. 

B: *Location:  This is the description label for your location. 

C: Product_ProductLine_Id:  This is field #2 in an inventory data record. 

D: *Community:  This is the description label for an inventory-sharing community (“product line”).   

E: Product_PartNumber:  This is field #3 in an inventory data record. 

F: Product_Description:  This is field #4 in an inventory data record. 

G: Product_Quantity:  This is field #5 in an inventory data record. 

H: Product_UOM:  This is field #6 in an inventory data record. 

I: Product_NetPrice:  This is field #7 in an inventory data record. 

J: *Currency:  This is the currency selected in your account’s location record for the location identified 
in column B of this file. 

K: *Posted:  This is the date that the item record was last posted or updated. 

 

 

 

 



 
 
 

page 13 of 25 

POST INVENTORY tutorial 2016.10.20 PC.docx updated 2/3/21 

L: *Expiration:  This is the date that the item record will expire from your account, unless updated prior 
to this date or otherwise manually deleted. 

To convert this file to a properly formatted inventory data posting file, delete the first row and delete all 
columns for which the column header label starts with an asterisk (*). 
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How to Add One Inventory Data Record ______________________  Back to Contents 

 

 

Step #1: Click on the Add New Item link () to navigate to the Item: Add New Item screen (above). 

Step #2: If your account has more than one location set up, click on the Location drop-down list () to 
select the location to which you want to post this new item record. 

Step #3: Click on the Inventory-Sharing Community drop-down list () to select the community to 
which you want to post this new item record. 

Step #4: Enter a complete part number into the Part Number field ().  We recommend that you always 
use the manufacturer’s exact part number, if such exists. 

Step #5: Enter an available quantity into the Quantity field () and a brief unit of measure label into the 
Unit of Measure field ().  Refer to the list of recommended units of measure here. 

Step #6: Enter an offer price into the Net Price field ().  If you do not want to display a price, enter “0”. 

Step #7: Enter a brief description of the item into the Description field ().  This is an optional field, and 
may be left blank. 

Step #8: To save the new inventory data record that you have just entered, click on the SAVE button 
().  To cancel what you have entered and return to the POST INVENTORY screen, click on 
the CANCEL button (). 

 

 

 

  

 

 

 

  
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How to Edit or Delete One Inventory Data Record ___________  Back to Contents 

 

 

Step #1: To find a specific item to edit or delete, enter the complete part number, or a part of a part 
number into the Find a Part Number to Edit field ().  Then click on the SEARCH button ().  
All currently posted item records will appear in the bottom half of the POST INVENTORY 
screen.  To clear your search results, click on the RESET button (). 

Step #2: If your search result exceeds the number of records viewable on a single page, per the # Items 
per Page setting (), use the navigation buttons () to scroll through your search results.  
Click on any item () to edit it or to delete it.  This will bring you to the Edit screen (). 

Step #3: To delete the selected item record, click on the DELETE button ().  To edit the selected item 
record, change values in any of the fields on the Edit screen (), and then click on the SAVE 

button ().  To cancel any edited changes and keep the item record as previously saved, click 

on the CANCEL button (). 

 

 

 

 
 

 

 

 

  
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What Happens to Posted Inventory Data _____________________  Back to Contents 

By default, a new data file does not erase all of the data uploaded from a previous file.  Instead, 
inventory data records are processed individually when a new inventory data file is uploaded.  A unique 
inventory data record is defined by a unique permutation of these three fields:  Location ID, Product 
Line ID and Part Number. 

When a new inventory data file is uploaded: 

 Inventory data records not previously posted are added to the account. 

 inventory data records previously posted and uploaded in the most recently uploaded file have 
their Description, Quantity, UOM and Price fields updated, and the record’s time-stamp re-set. 

After you have successfully posted inventory data, what happens to it depends on these factors: 

 expiration setting in your location records 

 whether or not you have activated the “Auto-Delete Unrefreshed Records” feature on a location 
record 

Individual records posted to an account are deleted in any one of four ways: 

1. You manually delete one record at a time, by clicking on the DELETE button on Item Edit pop-up 
window, after searching for and then clicking on a selected record on the POST INVENTORY 
screen. 

2. You manually delete all items posted to a single location, or all items at once.  Refer to Delete 
Inventory function () on the POST INVENTORY screen. 

3. If the “Auto-Delete Unrefreshed Records” box () has been checked on your location record on 
the Edit Location pop-up window, then all records not added or updated via the most recently 
uploaded inventory data file will be deleted immediately after the system processes that file. 

4. The item auto-expires after the time period set up on your account.  Refer to the Inventory 
Postings Expiration field () on the Edit Location pop-up window.  For items posted with an 
expiration period set to “After 30 Days” or longer, account administrators and non-administrators 
set up to “Receive Reminders” will receive an email reminder five (5) days before items are 
scheduled to auto-expire.  An example of such an email is shown below. 
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Automating Your Inventory Data Uploads via FTP __________  Back to Contents 

Inventory data files may be transferred to WarehouseTWO over the internet using standard file transfer 
protocol (“FTP”).  This is the recommended process.  Benefits of automating your inventory data uploads 
are: 

 This process saves you time and money.  Once it is set up, you don’t have to create or upload inventory 
data files manually. 

 Your data will always be posted to your account.  Those who manually upload their data tend to forget 
to upload new data. 

 Your items will appear higher in SEARCH results.  (Items in SEARCH results are sorted by posted 
date, with the most recent dates appearing at the top of the list.) 

How your data file is created and then transferred to us depends on your company’s business system 
software.  Contact us to inquire if other WarehouseTWO members have automated their inventory data 
uploads with the same business system software that your company uses. 

To enable automated inventory data file transfers via FTP, you will need to have an FTP account set up 
on the WarehouseTWO server.  An FTP account is available to all members at level 2 and higher, subject 
to a one-time activation fee.  Contact us to ask for details.  Once your FTP account has been created, 
your FTP user name and password will be displayed in on the Member Information tab in Account 
Settings. 

 
 
The URL for the WarehouseTWO FTP server is ftp.warehousetwo.com. 
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Tips and Tricks ___________________________________________________  Back to Contents 

To get the best results with the POST INVENTORY feature: 

1. Be a good inventory-sharing partner to other WarehouseTWO members:  follow our Inventory-
Sharing Etiquette guidelines, particularly item #1 for Sellers:  “Honor the Price you Posted”. 

2. Assign the responsibility of uploading your company’s inventory data to one of your employees.  If 
this is not someone’s responsibility, it will not get done, and your company will miss out on 
opportunities to sell excess inventory or gain incremental revenue. 

3. Upload as many inventory data records as your membership level allows.  Uploading just a few items 
greatly restricts your chances of getting a sale. 

4. Automate your inventory data uploads to a daily (or nightly) event.  Your items will be seen by more 
WarehouseTWO members if your data is current and always uploaded. 

5. Participate in as many inventory-sharing communities as your membership level allows.  This will 
increase the chances of getting a sale. 

6. Use the manufacturer’s exact part number as the part number in your inventory data file.  Other 
WarehouseTWO members are searching by manufacturer’s part numbers.  Your items may not be 
found if you do not use the correct part number.  If your business system software does not contain 
the manufacturer’s part number, user WarehouseTWO’s RELATED ITEMS function to link your part 
numbers to the correct manufacturers’ part numbers. 

7. Always include an offer price for each one of your items.  If your item does not show a price in a 
SEARCH result, you are much less likely to be contacted by the WarehouseTWO member who found 
your item.  Member feedback tells us that users will not bother to contact a posting member if there is 
not a price, if other members have posted the same item with a price. 

8. Stratify your offer prices: 

 Offer your most commonly sold items at price that gives you at least a 20% profit margin 

 Offer your slow moving (but not dead) items at a price that gives you a profit margin of 10-to-15% 

 Offer your dead/excess items at < 80% of current purchase cost 

9. Keep your inventory data accurate.  You will earn a bad reputation among other WarehouseTWO 
members if you must repeatedly tell an inquiring member that the item that you have posted to your 
WarehouseTWO account is no longer available.  Upload your inventory data frequently and set your 
expiration period to no longer than “After 30 Days”. 

 

Got a Question? __________________________________________________  Back to Contents 

Got a question about this feature?  Let us help: 

a) Email us. 

b) Call us at 650.329.1592. 

c) Post your question to our LinkedIn group, WarehouseTWO Users Forum. 

 

  

https://www.warehousetwo.com/docs/reference_documents/WTWO_Inventory-Sharing_Etiquette.pdf
https://www.warehousetwo.com/docs/reference_documents/WTWO_Inventory-Sharing_Etiquette.pdf
mailto:customerservice@warehousetwo.com?subject=Question%20About%20a%20WarehouseTWO%20Feature
http://www.linkedin.com/e/vgh/2859242/
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Appendix I:  How UOMs are Converted When Uploaded ____ Back to Contents 

When an inventory data records is added or edited, the WarehouseTWO system modifies the unit of 
measure (UOM) text in these ways: 

 The text is truncated to the first four characters 

 The text is converted to all uppercase characters 

 Selected UOMs are converted to recommended values, per Table 1 

 
Table 1.  Auto-reformatting Step #3 Value Conversion Table 
 

Convert 
From… …to This  

Convert 
From… …to This  

Convert 
From… …to This 

BAG PKG  E EA  LITR LTR 

BG PKG  EA. EA  LT LTR 

BX BOX  F FT  LY YD 

C BOX  FOOT FT  PACK PKG 

CA BOX  FT. FT  PAIL PKG 

CL RL  GA GAL  PK PKG 

COIL RL  JUG PKG  REEL RL 

CRTN BOX  KT EA  ROLL RL 

CS BOX  LF FT  SF SQFT 

CT EA  LI IN  SI SQIN 

DRUM PKG  LITE LTR  YARD YD 
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Appendix II:  How to Remove All Non-Default Formatting from an 
Excel File ___________________________________________________________ Back to Contents 

An inventory data file in Excel that is acceptable to the WarehouseTWO system must be completely 
devoid of any non-default cell formatting.  Examples of non-default formatting include multiple fonts, 
deliberately justified columns of data, currency signs, and prices rounded to two decimal places. In some 
instances, an Excel file created by a business computer system (“ERP”) contains non-default cell 
formatting.  Below are three options for how to remove all non-default cell formatting from an Excel file, 
and how to convert an Excel file into a pipe-character delimited text file. 

 
Option A:  “Clear” All Formatting from an MS Excel File 

An easy way to eliminate all cell formatting is to select 
the entire range of cells in your file (), and then select 
“Formats” () in the “Clear” () option under the “Edit” 
menu. 

 

 

 

 

 

 

 

 

 

 

 

 
Option B:  Transfer Data (“Values” Only) to a New Excel File 

If Option A above does not result in a data file that uploads successfully, follow these steps to move the 
contents of the original file into a new, default-formatted Excel file. 

Step #1: Start with an MS Excel file containing the required seven columns of data.  It must include the 
column headers in row 1, copied directly from the MS Excel inventory posting template file 
(downloadable from the POST INVENTORY screen).  Your file may look similar to this: 

  

 Notice the green triangles in the upper left-hand corners in the cells in the first two columns.  
They denote that numerical values have been entered as text.  Also notice that the first two 
columns of data are left-justified.  Finally, notice the dollar signs and fixed decimal places in 
the price cells. 

Step #2: To convert numbers-as-text into numeric values, enter the value of “1” into cell H2.  Click on 
cell H1 again, and select the “copy” function (Ctrl+C).  Next, highlight all of the cells in the first 
two columns that contain data.  (Do not highlight the entire first two columns!  Doing so will put 
zeros in the first two columns for thousands of rows beneath your data.) 

 

 

 
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 Under the “Edit” menu, select “Paste Special…”.  In the “Operation” section, click on the radio 
button next to “Multiply”, and then click “OK”. 

  

 The file should look like this: 

  

 Repeat Step #2 for any other column that should contain numeric values, but appears to 
contain numbers-as-text.  (Candidates are columns E and G.)  When finished, delete the value 
“1” in cell H2.  Caution:  It is not recommended that you perform this function on either column 
C or column D.  In some instances, MS Excel will change the part number or description, such 
as dropping leading zeros in all-numeric part numbers.  Also, MS Excel tends to interpret 
some part numbers as “scientific notation”, converting valid part numbers such as “47020E-
120” into numeric values such as “4.702E-116”.  The best way to avoid this is to not put your 
data into and MS Excel file to begin with. 

Step #3: Open a new, blank MS Excel file:  under the “File” menu, select “New…”; in the pop-up menu 
on the far right of the screen, click on “Blank workbook”. 

Step #4: Ensure that this new MS Excel file contains just one worksheet: 

  

 If this new file contains more than one worksheet, delete the extra worksheets by clicking on 
the extra worksheet’s tab; under the “Edit” menu, select “Delete worksheet”.  Repeat for all 
extra worksheets. 

Step #5: Go back to the original MS Excel file.  Select, by highlighting, the entire range of data, 
including row #1, which contains the required column header labels.  Select “copy” function 
(Ctrl+C).  Go to the new, blank MS Excel file.  Click on cell A1.  Under the “Edit” menu, select 
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“Paste Special…”.  In the “Paste” section, click on the radio button next to “Values”, and then 
click OK. 

  

 Click on any single cell.  Your completely unformatted MS Excel file should look like this: 

  

 

Column width is not important.  You may expand or compress the column widths. 

Step #6: Save this new MS Excel file as your completely unformatted, numbers-as-values, single 
worksheet MS Excel inventory data upload file.  Upload this file. 

 
 
Option C:  Convert an Excel File into a Pipe-Delimited Text File (using “concatenation”) 

Another way to eliminate the problems caused by unintended formatting in an MS Excel file is to convert 
the file into a pipe-character-delimited text file.  This is the other file format that WarehouseTWO accepts 
for inventory data uploads. 

Step #1: Start with an MS Excel file containing the required seven columns of data.  It may include the 
column headers in row 1, copied directly from the MS Excel inventory posting template file 
(downloadable from the POST INVENTORY screen).  Your file may look similar to this: 

  

Step #2: Insert a blank column to the left of column A:  highlight column A; under the “Insert” menu, 
select “Columns”. 

Step #3: In cell A2, enter this formula, exactly as shown here: 

 =CONCATENATE(B2&"|"&C2&"|"&D2&"|"&E2&"|"&F2&"|"&G2&"|"&H2) 

 Your file should look something like this, just before you save the formula: 
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Step #4: Copy the formula in cell A2 down column A, so that every row of data has a formula in its 
corresponding “A” cell. 

Step #5: Highlight the entire column A.  Select the “copy” function (Ctrl+C).  Under the “Edit” menu, 
select “Paste special…”  In the “Paste” section, click on the radio button next to “Values”, and 
then click OK. 

  

 

 By expanding the width of column A, your file should look something like this: 

  

Step #6: Delete row A:  highlight the entire row by clicking on the “1” to the left of cell A1; under the 
“Edit” menu, select “Delete”.  Delete columns B through H:  highlight columns B through H by 
clicking on the “B” above column B; while keeping the mouse button depressed, move the 
curser over to column H; under the “Edit” menu, select “Delete”.  Your file should look 
something like this: 

  

Step #7: Save this file as a tab-delimited text file:  under the “File” menu, select “Save as…”.  In the 
“Save as type” drop-down menu, select “Text (Tab delimited) (*.txt)”; name your file, select a 
save-to destination, and then click on the “Save” button. 

 Click on the “Yes” button when this window appears: 
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 Close this file.  When the window below appears, click on the “No” button: 

  

Step #8: Find the text file you just created.  Click on it twice to open it up in Windows “Notepad”.  The 
file will look something like this: 

  

If any of your descriptions contained a quotation mark (“) or a comma (,), then the text file you 
just created now contains unwanted quotation marks surrounding selected data strings, or 
within the strings.  These unwanted quotation marks must be removed.  Failure to do this will 
result in the offending lines of data not getting uploaded at all, and error messages will appear 
when the file has been uploaded and processed. 

 To remove these unwanted quotation marks, follow steps #9 through #12. 

Step #9: Under the “Edit” menu, select the “Replace…” function (Ctrl-+H).  Enter two quotation marks in 
the “Find what” field and four Qs in the “Replace with” field. 

  

 Then click on the “Replace All” button.  Wait a few seconds for the replacements to take 
effect.  The above window will remain open. 
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Step #10: Remove one of the quotation marks from the “Find what” field and remove all of the Qs from 
the “Replace with” field. 

  

 Then click on the “Replace All” button. Wait a few seconds for the replacements to take effect.  
The above window will remain open. 

Step #11: Enter four Qs in the “Find what” field and enter one quotation mark in the “Replace with” field. 

  

 Then click on the “Replace All” button. Wait a few seconds for the replacements to take effect.  
The above window will remain open.  Close this window by clicking on the white “X” in the red 
box in the top right-hand corner.  Your file should now be cleaned of unwanted quotation 
marks: 

  

Step #12: Save this file.  You now have a clean inventory data file in pipe-character-delimited text file 
format. 


